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Pro Control Studio 

 

Introduction: 
Pro Control Studio is a powerful, easy-to-use, Windows based software package that allows an entire 
Pro Control system to be programmed from a PC.  It includes a wide variety of powerful tools that make 
the programming process quick and easy. 

Pro Control Studio provides complete flexibility in the design of the graphic user interface (GUI).  Several 
pre-defined buttons, symbols and page templates are included in the software. 

In addition, the software includes robust infrared, RS-232, and Driver libraries.  Commands are stored 
and can be reused in multiple systems and are added to any Macro by a simple mouse-clicking process.  
An auto-programming feature allows simple and fast system configuration. 

Pro Control Studio provides a simple interface enabling every button in the system to carry out complex 
multi-step actions. 
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Glossary of Terms: 

 
Pro Control Devices: Pro Control handheld controllers and/or control processors. 

Controlled Devices: Third-party equipment such as A/V receivers, cable boxes, and DVD players. 

Properties:  Configuration settings applying to Pro Control Devices, Buttons, or Macros. 

Value:   Adjusted properties applying to Devices, Buttons, or Macros. 

Commands:  Infrared, RS-232, or TCP/IP instructions to a third-party device. 

Driver: Software files allowing 2-way control and feedback of a Controlled Device (e.g.  
A/V Receiver), or a Widget/Non-Device (e.g. Weather Driver, Clock Driver). 

Macro: Single command or series of commands containing Commands, Page Links, Time 
Delays, etc. used to control and automate the system. 

Download:  Sends Pro Control Studio System File to Pro Control Devices. 

Pages:   Touch panel Buttons, Graphics, and Hard Buttons associated as a User Interface.  

Screens:  Additional “frames” of touch panel graphics and buttons associated to a Page. 

Buttons: Buttons are the functional elements of a Pro Control system. Remote control 
devices include physical “hard” buttons that are programmed with frequently 
used commands. Touch panels allow for buttons that are drawn and 
programmed using the Pro Control Studio software tools. All buttons can be 
associated with Commands, Macros, and Page Links. 

Templates:  Pre-defined sets of pages with a common appearance and functionality. 

System File:  All programming for Pro Control Devices associated to a specific system. 

Soft Key(s):  Hard buttons with variable use, based on touch screen graphics. 
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Getting Started: 

Powering the Pro Control Devices 

 

Handheld Controllers 

The power switch for the handheld controllers (remotes) is located on the back of the device, inside the 
battery compartment.  Once the system is programmed for daily use, this switch should remain in the 
ON position.  If the system will not be used for an extended period of time, the user may turn the device 
OFF.  Prior to long term storage, please ensure the battery is fully charged. 

To access the power switch, locate the battery cover on the back of the device. 

To remove the cover, press the top of the cover and slide off the cover.  The power switch is located 
directly above the battery compartment. 
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Processors  

Pro Control processors do not have a power switch.  They are powered and ready for use when plugged 
into the provided power supply. 

 

 

Charging the Handheld Controller 
To charge the battery on the Pro24.r, locate the Charging/Programming port on the bottom of the 
handheld controller.  The Pro24.z may be charged via the port, or the provided charging dock. 

 

 

Plug the provided charging cable into a nearby wall socket, and insert the USB connector into the 
Charging/Programming port. 
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The red charging LED on the front of the controller will flash while the device is charging.  When 
charging is completed, the LED will illuminate steadily.  Once fully charged, the device is ready for use.  
The device may continue to be used while the device is charging. 

 

 

 

 

Locating the Programming Port 

 

Handheld Controllers: 

To load the System File into the handheld controller, locate the Charging/Programming port on the 
bottom of the device.  Connect the provided programming cable into this port (USB B) while the 
controller is ON.  Plug the other end of the cable (USB A) into the computer used to program the device 
with Pro Control Studio. 
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Processors 

To load the System File into the processor, locate the Programming port on the left side of the device 
(labeled “USB”).  Connect the provided programming cable into this port (USB B).  Connect the other 
end of the cable (USB A) into the computer used to program the device with Pro Control Studio. 

 

 

Processor LED Icons 

 POWER STATUS NET LINK RF LINK RF DATA IR IN IR OUT SENSE 

 
        

LED 

On when 
unit is 

powered 
up 

Solid when 
not 

programmed 
and briefly 
upon first 
power up. 
Will flash 
with any 

activity sent 
or received 

from the unit 

Solid 
when 

network 
detected, 
flashing 
when 
seeing 

network 
traffic 

Solid when 
RF 

connection 
is setup 

and ready 
for data 

Flashing 
when 

transmitting 
or receiving 

RF data 

Flashes 
when IR is 
received 

in the 
processor 

Flashes 
when IR is 
sent from 

the 
processor 

Flashes 
when 
data is 
sent or 

received 
through 
a sense 

port 
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Button Layout 

 

Pro24.r  Pro24.z 

 

 

Firmware Version and Updating 
Current firmware version is viewable in the “Download” window.  Click the “Download” button while 
the Pro Control Device is plugged in via the USB programming cable.  Select the device from the list to 
view.  If a more current firmware version is available, download it from the Pro Control website.  Click 
“Update Firmware”, and follow on-screen instructions. 

 

 

“Soft Keys” to correlate with graphics 
on the touch screen 

5-way joystick (Pro24.z only) 

Power buttons (Pro24.r only) 

Cursor keys 

 

Color buttons 

Transport keys 

 

Numeric keypad 
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Limited Warranty 
Pro Control warrants its products for a period of one (1) year (90 days only for included battery packs); 
or for a period of time compliant with local laws when applicable from the date of purchase from Pro 
Control or an authorized Pro Control distributor.  

This warranty may be enforced by the original purchaser and subsequent owners during the warranty 
period, so long as the original dated sales receipt or other proof of warranty coverage is presented when 
warranty service is required.  

Except as specified below, this warranty covers all defects in material and workmanship in this product. 
The following are not covered by the warranty:  

Damage resulting from:  

1. Accident, misuse, abuse, or neglect.  

2. Any product purchased via unauthorized channel or internet website.  

3. Failure to follow instructions contained in this Guide.  

4. Repair or attempted repair by anyone other than Pro Control.  

5. Failure to perform recommended periodic maintenance.  

6. Causes other than product defects, including lack of skill, competence or experience of user.  

7. Shipment of this product (claims must be made to the carrier).  

8. Being altered or which the serial number has been defaced, modified or removed. 

 

Repair/Return Process 

Pro Control customer service is available for authorized dealers requiring assistance with product 
warranty questions and repair issues. 

Pro Control customer service may be contacted by both email and phone: 

  service@procontrol.com 

  1-952-224-5020 

  Customer service hours, excluding holidays:  8:00am to 5:00pm Monday – Friday CST 

mailto:service@procontrol.com
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Technical Support 
Pro Control technical support is available for authorized dealers requiring assistance with products and 
programming issues. 

Pro Control technical support may be contacted by both email and phone: 

  support@procontrol.com 

  1-952-224-5024 

  Technical support hours, excluding holidays:  8:00am to 5:00pm Monday – Friday CST 

 

 

Programming Overview 

Step-by-Step 

 

1. Install and open Pro Control Studio programming software. 
 

2. Add Pro Control Devices to the System File.  Adjust Properties as necessary. 
 

3. Add Controlled Devices.  Adjust Properties as necessary. 
 

4. Add Pages via Templates or build custom pages. 
 

5. Confirm Auto-Programming and adjust as necessary. 
 

6. Create Macros to simplify and automate the operation of the system. 
 

7. Download System File to Pro Control Devices. 

 

mailto:support@procontrol.com
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Install and Open Pro Control Studio 

 

 

Install Pro Control Studio 

See Appendix A for installation instructions and information. 

 

Open Pro Control Studio 

Once installed, Pro Control Studio may be accessed through the “Start” menu.  A Desktop shortcut may 
be created as well.   

 

 

 

Verify that Pro Control Studio is running the current version by clicking the “Help” button on the toolbar 
at the top of Pro Control Studio.  Select “Check for Updates”.  When opening Pro Control Studio, a pop-
up window may inform you of a new version available. 
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Help/Quick Start Assistant 

The Pro Control Quick Start Assistant provides a basic, step-by-step overview to quickly program a basic 
system.  It may be accessed via the “Help” button. 

 

 

 

Add Pro Control Devices to the System File 

 

Add the required Pro Control Devices to Pro Control Studio.  Click the “Add” button in the upper left 
corner under the “Pro Control Devices”.   

A list of Pro Control Devices will be exposed.  Select Pro Control remote controllers as necessary.  Only 
one processor may be added to a System File.  A System File may contain only compatible devices (i.e. 
Pro24.z remotes with ProLink.z processor).   Incompatible devices will not be selectable from the list. 
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After selecting the Pro Control device, it may be named (e.g. “Living Room Remote”).   Add all Pro 
Control devices used in the system in this manner. 

 

 

 

The selected Pro Control Devices will appear in a list in the “Pro Control Devices” section. 

 

 

 

The Pro Control devices may be renamed at any time by right-clicking the existing name and selecting 
“Rename”. 

To remove a Pro Control device, highlight it and select the Delete button. 
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Properties 

Adjust the Properties for each Pro Control Device by highlighting the Pro Control Device from the list.  
Properties are listed on the far-right side of Pro Control Studio.  A description of the property’s function 
is viewable at the bottom of the Property list. 

 

Remotes 

 

 

Enable Tilt Switch:   Activates the touch screen when the controller is moved. 

Ignore First Press: If the Tilt Switch is disabled, allows any button to wake up the 
touch screen, without sending the macro. 

Beeper: Provides audible button press feedback for touch screen 
buttons, all buttons, or no buttons. 

Volume (Pro24.z only):   Adjusts Beeper volume between 0 and 100.   

Tone (Pro 24.r only):   Adjusts Beeper volume to Low or High. 

Backlight Timeout: Adjusts wait time (in seconds) for the backlight to return to idle 
state.  Value 5 to 90. 

Backlight Level:    Adjusts brightness of the touch screens backlight. 
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Enable Page Swipe (Pro24.z only): Allows “swiping” gestures to change screens within a page. 

Processors 

 

System Zone Code: Setting a unique System Zone Code allows individual operation 
of multiple Pro Control systems located within the same 
installation or systems located in close proximity to each other 
(i.e. a close neighbor that has a Pro Control system) without 
cross communication issues.  Programmers are strongly 
encouraged to change this from the default value. Value 0 to 
255. 

Channel (ProLink.r only): Choose a different channel when encountering environmental 
interference or when encountering interference from other Pro 
Control systems.  Value 1 to 13. 

Network Key: Encryption key that is unique to every system file.  Not related 
to WiFi security.  The default key should be used in most 
scenarios.  Accessed by right-clicking on the Device. 

Use DHCP to configure networking: Allows the processor to automatically configure network 
settings.  If false, a static IP address may be assigned 
(recommended). 

Enable Network Programming: Allows the processor to be programmed over the network.  If 
false, a Pro Control programming cable will be necessary to 
program. 

IR Port Names: Provides the ability to name the IR output ports for easy 
recognition and IR port routing (TV, DVD, etc.). 

RS-232 Port Names (Prolink.z only): Provides the ability to name the RS-232 output ports for easy 
recognition and port routing (TV, DVD, etc.). 
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Add Controlled Devices 

 

The Controlled Devices section allows the programmer to select the components in the system, such as 
televisions, receivers, cable boxes, etc.  Click the “Add” button and select the appropriate control 
method:  IR, RS-232, or Driver.   

 

 

 

IR:   A device controlled via infrared commands, either directly from the handheld 
controller, or an IR emitter connected to a Pro Control processor. 

RS-232:  A device controlled via RS-232 serial commands (ProLink.z only). 

Driver: A device or a widget/non-device (Weather Driver, Clock Driver) that may provide 
feedback or metadata to the Pro Control system.  This option is limited to available 
drivers (ProLink.z only). 

 

Choose the desired component from the “Select Remote from Library” window by clicking on the 
correct code set.  The search bar at the top of the library may be used to quickly locate components.  

Note:  There will not be a code set for every manufacturer model, as many manufactures reuse codes 
between similar models.  Try a similar model if a particular code set is not available. 
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After selecting a Controlled Device from the Library, Pro Control Studio will suggest Pages for that 
device.  Click the Suggested Page to preview.  The Controlled Device may be renamed (e.g. “Bedroom 
TV”). 

 

 

 

The selected component will appear in the “Controlled Devices” section.  Repeat the process for all 
components to be controlled.  
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Properties 

Adjust the properties for each controlled device.  Use the “IR sent from” field to determine if the IR 
commands for this component will be issued from the handheld controller or from an IR emitter 
connected to the processor.  If the IR command is issued from the processor, the command may be 
routed through any (or all) ports as necessary.  If the system contains multiple devices using the same IR 
code set (e.g. cable boxes), a command may be routed to a specific port to eliminate cross-
communication.  

 

 

Continue to adjust the properties for RS-232 controlled devices (ProLink.z only) by selecting the 
appropriate port assignment for the controlled device and communication settings (Baud Rate, etc.).  
Driver properties (ProLink.z only) may be adjusted in a similar manner, options will vary by device. 

 

 

 

Learning IR Commands 

See Appendix B for instructions and information regarding IR learning. 
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Pages 

Select the remote control (Pro24.z, in this example) from the list of Pro Control Devices, and click the 
“Edit” button.  

 

 

 

The resulting window presents the interface for programming the remote control.  A view of the hard 
button portion of the remote is shown to the left while the color touch screen resides in the center of 
the program. The right side of the program is where the designer can assign, change and/or manipulate 
the desired functionality and appearance. 
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The Pages currently on the controller may be viewed by selecting the “Pages…” button at the top of the 
programming window.  This will open a separate window showing all pages and frames currently on the 
selected controller. 

 

 

 

A Page may be selected for programming from this window by double-clicking on it.  Additional Screens 
may be added to a Page by right-clicking on the Page>Insert Blank Screen. 

Pages may also be selected for programming by using the pull-down list “Current Page:” on the top 
toolbar. 
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Adding Pages 

To add more Pages to the Pro Control remote, select the “Add” button and choose “Add Blank Page”, 
“Add Page(s) from Template”, or “Import Page” 

 

 

 

Adding Pages from Template 

When adding pages from Template, choose a Theme and select the desired pages by placing a 
checkmark in the corresponding box.  The Suggest Pages feature auto-selects pages based on the 
Controlled Devices added to the system.  The Template Pages are completely customizable, and may be 
modified to suit the needs of the project. 
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Each Page may contain multiple Screens.  Screens provide expansion of a single page when more space 
is needed.  Screens are reflected by the green numbers in the upper right hand corner of the touch 
screen.  The auto program application automatically links one of the buttons to the corresponding 
screen.  The screens are viewable in the “Pages…” window. 

 

Creating Pages 

When adding a Blank Page, the “New Page Title” window will appear and prompt for a page name (e.g. 
Home Page, Watch TV, etc.).  Creating a blank page will result in a blank screen that may be customized 
to suit the system. 

 

 

 

Pro Control Studio features an interchangeable grid which the programmer may find useful when 
designing the layout.  It can be set to none, 10x10, or 20x20 to align multiple buttons on a page. 
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The “Images” tab on the right side of Pro Control Studio contains several graphic icons to construct a 
page from scratch, or modify an existing page.  They may be placed on the touch panel screen by 
dragging and dropping to the desired location. 

 

 

 

Toolbars 

Pro Control Studio features “toolbars” used to make changes to any touch panel button in reference.  
The programmer may adjust button layering, alignment, position, size, location, relative position, and 
distribution on the page.  Placing the cursor on a tool will explain the function. 
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Top Toolbar: 

Toggle left and right between different screens on the selected page. 

 Button selection and creation bar, use the red square button to select and 
manipulate buttons on the screen.  Rectangle, rounded rectangle, and ellipse 
draw buttons are also available here. 

 Visible toggle allowing the user to see hidden buttons which are tied to the 
visible driver binding. 

  

Bottom Toolbar: 

 Moves a selected button to the back, front, or any layer in between.  Helps 
create layers while using overlapping or invisible buttons. 

Aligns multiple buttons in reference to the last button selected,  i.e. pressing 
the Align Left key will bring all selected buttons to the same left position 
coordinates of the last button selected. 

 Center the selected button either vertical or horizontal. 

 Equally spaces multiple buttons between each other across, top down, 
horizontally, and vertically.  

 Sizes multiple buttons in reference to the last button selected,  i.e. pressing 
the same size key will make all objects the same size as the last button that 
was selected. 

 Styles multiple objects in reference to the last button selected.  This applies to 
button options, text format, and border format only. 

 Moves the selected objects up, down, left, and right, by one pixel. 

First set of numbers is the current coordinates of the cursor.  The second set 
of numbers is the width and height of the current selected button. 
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Located above the programming window, several button draw options are available.  These tools allow 
the programmer to draw buttons in several shapes as needed. 

 

 

 

The Selection tool (red dashed box shown above) allows the programmer to select a button by clicking 
it, for purposes of adjusting size, properties, location, etc.  Multiple buttons may be selected by holding 
the “SHIFT” key on the keyboard while selecting buttons. 

 

 

 

Using the “Properties” tab, customize the appearance of the Buttons and Page as desired, including 
Background Color, Button Color (Normal and/or Active), adding Text, Font, Line (border) Width, Line 
Color, Alignment, and more. 
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Importing (Merge) Pages 

Merge Pages allows the programmer to Import a Page from a similar Pro Control remote created earlier.  
This allows re-use of a pre-programmed Page in multiple systems.  Select “Import Page” from the “Add” 
pull-down list. 

From the resulting window, choose the location of the Pro Control Device. 

 

 

 

Navigate to the proper location, and choose the System File containing the desired Device. 
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Choose the Device containing the Page(s) to Import. 

 

 

 

Select the Page(s) to add, and select “OK”.  The Pages will be Imported to the current Pro Control 
remote. 
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Editing Added Pages 

Selecting the “Pages…” Button above the programming window allows viewing and editing of all Pages 
and Screens on the selected Pro Control Device. 

 

 

 

Right-clicking on a Page or Screen allows Inserting, Deleting, Copy/Paste, and relocation of the selected 
Page or Screen. 
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Auto-Programming 

The Templates utilize an auto-programming feature which assigns commands to some buttons based on 
the list of devices to be controlled.  For example, the DVD Player page has commands automatically 
assigned for Play, Fast Forward, etc.   

 

 

 

A green “check-mark” on the top left corner of a Button indicates a Macro exists on that Button.  
Selecting a Button allows the programmer to view and edit the Macro as necessary. 

The green hard buttons (volume and mute in this example) indicates a “Global” button, meaning the 
Macro assigned to those buttons is the same for each page.  Any hard button may be configured as 
Global by right-clicking and selecting “Make This Key Global” 

If necessary, the auto programming may be modified.  The “Properties” tab and “Macro” tab allow 
altering a Macro if desired.   
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Pro Control Studio’s auto-program feature will automatically populate a Home Page with icons 
representing the various sources or activities, based on the Pages or Controlled Devices added to the 
system.  It is recommended that all Controlled Devices and Activities are added prior to rearranging the 
icons.  Adding new Devices or Pages may disrupt the customized configuration. 

The “Placeholders” are not visible on the final program if those activities are left empty. 
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Adding Driver Feedback (Pro24.z & ProLink.z only) 

A variety of feedback options may be used to display metadata from installed Drivers.   

Button Text Feedback 

Text feedback allows the user to see, in real-time, the changes made to a system, such as volume status, 
now playing information, tuner frequency, etc. 

To add Text feedback to a button, select the desired button using the Selection tool, and navigate to the 
Button Properties.  Choose Text color, font, etc. 

In the Text entry field, click the “Arrow”, and select the Driver to poll for information. 

 

 

Choose the Variable to display on the button. 
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“Placeholder” text will be placed on the button, so the programmer may edit text size, color, font, etc. 

 

 

The text entry field will represent this Variable with a (var) indicator.  Additional text may be added as 
needed to the field. 
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To view or remove the Variable, click the (var) indicator. 
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Button State Feedback 

Pro Control Studio allows Button feedback as Reversed (Pressed), Inactive, and Visible states.  Any 
True/False-type Driver Variable may be expressed as a Button Variable. 

 

Reversed 

Instructs the button to display the Reversed image when assigned.  This can provide positive feedback 
for source selection, power state, etc.   

 

Inactive 

Instructs the button to become unresponsive to button presses.  No Macro Steps or button press 
confirmation will occur. 

 

Visible 

Instructs a button to appear or disappear, based on Driver feedback.  Use the “Show Buttons…” tool to 
view hidden buttons. 

   

 

 

To assign: 

Locate Button Variable Bindings under Button Properties. 
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Assign the Button Variable Binding to the desired Driver information. 

 

 

 

The Variable will be displayed in Button Variable Bindings. 
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      Power On:              Power Off: 
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Create Macros 

A Macro allows the programmer to simplify and automate control for the end-user.  A Macro may 
consist of a single command, a Page Link, or a complex series of steps 

Steps may be added to the macro by utilizing the “Add” button.  Selecting “Add” opens the “Add Macro 
Step” window which allows the programmer to assign different commands and features to the button.  
Macro steps run in the order that they are listed, and may be rearranged. 

 

 

 

Selecting the “Delete” button removes the item in reference.  In the illustration, the “Delete” button will 
remove the “NEXT” macro step (highlighted) for the DVD Player Page. 
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Macro Step Definitions 

 

Delay:   Adds an adjustable pause between Macro steps. 

 

Stop: Prevents Macro from running beyond determined point; may be used with 
conditional logic. 

 

Button Pause: Step causes the Macro to stop executing until the button it is attached to is 
released, at which time the rest of the macro is executed. 

 

Repeat Steps: Step causes the macro to output a group of steps multiple times. You can 
choose whether to repeat the steps a fixed number of times or continuously 
while the button is held down. 

 

Beep:  Plays a sound effect during the Macro. 

 

Comment:  Allows text entry within a Macro; used for notes or comments. 

 

Toggle IR Code: Causes the macro to alternate between two different IR codes every other time 
the button is pressed. If you have equipment that uses toggle codes, you must 
learn each code twice, and then place the two codes within the Toggle IR Code 
step. Every time the macro is run, it will send out only one of the two codes 
inside of the Toggle IR Code step, switching back and forth each time the button 
is pressed. 

 

System Variable Test: Tests the state of any Boolean (true/false) variable from an installed Driver, and 
allows conditional logic based on the status.  

Power Sense: Tests the state of a processor’s sense input for presence of voltage (+3 volts), 
and allows conditional logic based on status. 
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Button Test: Causes the macro to execute a group of steps ONLY IF the button that the 
macro is attached to is pressed (or not pressed, or double-clicked, depending on 
the option selected). 

 

Devices: Allows access to the IR, RS-232, or Driver Libraries for adding a command step to 
the Macro. 

 

Flags: The Flag step is used to keep track of system status and act based on that 
status. There are multiple flags available, which you can set or clear under 
macro control. Later, you can use the "Test Flag" option to take different actions 
based on whether or not a certain flag is set. 

For example, you can use this functionality to make discrete power ON and OFF 
macros for components for which you have only toggle codes. Use the "Set Flag" 
option when you turn on the component, the "Clear Flag" when you turn it off, 
and the "Test Flag" option before you send out the Power code. 

 

Page Link:  The Page Link step causes the macro to change the currently displayed page. 
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Macro Examples 

Adding a Command to a Button 

A Macro may consist of a single command.  To add a “Volume” command to a hard button, select the 
button by clicking it, ensuring that the “Select Button” tool is engaged.  The button will turn RED when 
selected. 

 

 

 

Choose the Macro tab at the upper-right of Pro Control Studio, and select “Add”. 

 

 

 

 



V0.3 [PRO CONTROL STUDIO REFERENCE GUIDE V1.0] 

 

 

Page | 44 

The “Add Macro Step” window opens, allowing the programmer to access Controlled Devices and 
macro commands.  The window is re-sizable and may be positioned where desired. 

 

 

 

Under “Devices”, locate the appropriate Controlled Device.  Double-click on the command, and the 
Macro is complete. 
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Creating an Activity 

An Activity, in this case Watch TV, can be easy for the end-user to understand.  In order to simplify and 
automate this process, several Controlled Devices will need to be turned on, appropriate inputs 
selected, etc. 
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Rename the auto-programmed “Cable TV” button by selecting the Properties tab after selecting 
the button. 

 

 

 

In “Button Text” properties, the programmer may edit the button’s text, font, font size, 
alignment, justification, and text color for both Normal (not pressed) and Active (pressed) 
states. 

Adjust the existing, auto-programmed Macro on the button by selecting the Macro tab. 
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The existing Macro contains a Page Link to the Cable TV page (on the remote), and a short Time 
Delay on the processor. 

  

To add additional commands, select the “Add” button.  The “Add Macro Step” window opens, 
allowing the programmer to access Controlled Devices and macro commands.   
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From the “Add Macro Step” window, find the required commands to operate the equipment.  In 
this example, there is an IR controlled satellite TV box, an RS-232 controlled TV, and a Driver 
controlled A/V receiver. 

To add commands, select: 

Device> (name of Controlled Device)> (name of command needed) 

In this example: 

Device>Plasma>Power: ON 

 

Double-clicking on the command will add it to the Macro. 

 

 

 

Continue to add the required commands in the same manner.  Driver commands may have 
parameters adjustable by the programmer, as shown: 
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After all required commands have been added to the Macro, the order may be rearranged as 
needed by dragging the command up or down the list. 

 

 

 

If needed, other commands may be added to the Macro.  See Macro Step Definitions for more 
information. 
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Using Power Sensing  

Occasionally a discrete IR code may not be available for a Controlled Device.  If the device 
outputs voltage when powered on, like a projector or cable box, the ProLink processor can 
monitor the power state and act accordingly. 

In this example, a projector with a +12 volt DC output for a screen trigger is used.  Connect the 
trigger to one of the Sense Inputs of the processor. 

In the Macro, add the toggling “Power” command. 

 

 

 

To monitor the Sense Input, use the Macro Step “Power Sense” 
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When “Power Sense” is added to the Macro, a Conditional Statement is used.  This allows the 
processor to execute Macro Steps, based on the status of the Sense Input. 

 

 

 

Drag the “POWER TOGGLE” command into the appropriate bracket of the Conditional 
Statement. 

 

 

 

How it works: 

 

 Step 1: The Macro, seeing the Power Sense command, tells the processor to check Port 
 1 for any voltage present. 

 Step 2: If no voltage is present (OFF), the processor executes the command “POWER 
 TOGGLE”, turning the device ON (the toggle command reverses the current 
 power state of the device). 

 Step 3: If voltage is present (ELSE), the macro does nothing, as there is no command in 
 the ELSE bracket of the Conditional Statement. 

 

 

 



V0.3 [PRO CONTROL STUDIO REFERENCE GUIDE V1.0] 

 

 

Page | 52 

Using Flags 

Pro Control processors and handheld controllers each have 255 nameable Variables called Flags.  
Flags are a powerful tool for tracking status, such as power state, source selection, and more. 

Each Flag has 4 possible operations available as a Macro Step:  Set, Clear, Toggle, and Test. 

 

 

 

The “Clear” operation sets the Flag’s value to “False.” 

The “Set” operation sets the Flag’s value to “True.” 

The “Toggle” operation inverts the Flag’s current value (True to False/False to True). 

The “Test” operation allows a conditional statement to execute Macro commands, based on a 
Flag’s current value. 

 

Flags may be named according to the desired use.  Access the Flags via the “Flag” button in the 
Macro tab. 
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Note that the Remote Control and Processor each have a unique set of 255 Flags. 

 

 

 

 

 

Simulating Discrete IR Commands with Flags 

Flags may be used to simulate discrete control of a device that only has a toggle power 
command.  In the example below, a cable TV tuner with non-discrete IR power commands is 
controlled in an Activity, ensuring the power state is ON. 

Note:  Flags are tracked by the Pro Control device only.  External changes to the system (OEM 
remote, device buttons, power failure) may cause Flags to lose track of current power state. 

In order to use Flags in this application, the programmer must be certain to Set the Flag (Cable 
TV Tuner, in this example) each time the device is powered ON.  The same Flag must be Cleared 
each time the device is powered OFF.  The system is tracking the Flag’s status, rather than the 
actual power status of the device.  This is critical for proper operation. 
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To simulate a discrete “Power ON” command: 

 

 

 

For the “Power ON” Macro, a Test Flag operation has been added to the Macro.  This gives a 
conditional statement to test the current value of the selected Flag (Cable TV Tuner). 

 

If the Flag is Set (True), then assume the device is ON.  The top bracket of the conditional 
statement will be left blank (no commands).  The device will remain ON. 

 

Else, indicating that the Flag is Cleared (False), indicates the device is OFF.  Insert the toggle 
power command to turn the device ON, and Set the Flag (Cable TV Tuner) to indicate the device 
is ON next time it is tested. 
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To simulate a discrete “Power OFF” command: 

 

 

 

For the “Power OFF” Macro, a Test Flag operation has been added to the Macro.  This gives a 
conditional statement to test the current value of the selected Flag (Cable TV Tuner). 

 

If the Flag is Set (True), then assume the device is ON.  Insert the toggle power command to turn 
the device OFF, and Clear the Flag (Cable TV Tuner) to indicate the device is OFF next time it is 
tested. 

 

Else, indicating the Flag is Cleared (False), indicates the device is OFF.  The bottom bracket of 
the conditional statement will be left blank (no commands).  The device will remain OFF. 
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Using Button Variables with Flags 

Button Variables (available in Button Properties) may be used in association with Flags.  This 
can provide feedback of the Flag status to the user. 

The example demonstrates using Flags to indicate the current Activity selected.  The Activity 
buttons (DVD, Cable TV) are programmed to reflect the current Activity by showing their 
Pressed (or Reversed) state. 

 

 

 

The Button Text for each Activity button has been programmed to display RED text for the 
Pressed state, and WHITE text when not pressed. 
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A Flag is designated for each Activity, and named as described earlier.  Select “Button Variable 
Bindings”, found in the properties of each Activity button.  Set the “Reversed” Variable to 
correlate with the Flag for the respective Activity. 

 

TV Activity:               DVD Activity: 

  

 

In the Macro for each Activity, Set the appropriate Flag, and Clear the Flag for the unselected 
Activity.  Only 1 Flag should be selected at a time in this application.   

Note: This example is using the Flags on the Remote Control. 

 

            TV Activity:                DVD Activity: 
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Additionally, multiple variables may be bound to a single button.  Expanding on the previous 
example, the programmer may choose to “lock”, or render a button Inactive, if an Activity is 
selected.  This would prevent the Macro from executing if the Activity was already in use. 

 

 

 

Using Variable Text with Flags 

Button Text may be defined, based on the status of a Flag.  Expanding on the previous example, 
the top button on the Activity selection Page will update its text to reflect the selected Activity. 
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Select the button, using the Selection tool, by clicking it. 

 

 

 

Under Button Properties, locate the Button Text property.  Enter any desired text, in this 
example “Now Playing:” 

 

 

 

To add a Text Variable, select the “Arrow” in the text entry field.  From the pull-down list, select 
Local Macro Flags> (choose the designated Flag). 
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A Variable will be entered into the text field. 

 

 

Click on the Variable to edit displayed text. 

 

 

The handheld controller will now reflect the current selected Activity on the button. 
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Testing Two-way Variables 

Pro Control Studio allows the programmer to test Driver Variables as a Macro Step.  This 
provides the ability to create a more intelligent system by relying on feedback directly from a 
Driver, rather than Flags or other, less certain variables or executing unnecessary Macro Steps. 

Select “System Variable Test” from the “Add Macro Step” window. 

 

 

 

Under “Properties”, select the Driver and the Variable to test. 

Note:  Only Boolean (True/False) Variables may be tested. 

The Macro will confirm the Driver’s status, and allow the programmer to base conditional logic 
within the Macro. 
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IR/RF Macro 

In some applications, it will be necessary to have some Controlled Devices receive IR commands 
directly from the handheld controller, while other devices must be controlled by the processor, 
in the same Macro. 

For example, the TV may be a rear-projection model that has no location for an IR emitter, and 
the A/V receiver and cable TV tuner are in a rack located elsewhere. 

In the Properties of the Controlled Device requiring direct IR control from the remote, select 
“Remote Control” in the “IR sent from” field. 

 

 

 

For the Controlled Devices connected to the processor, select “Processor” in the “IR sent from” 
field. 

 

 

 

 

 

 



V0.3 [PRO CONTROL STUDIO REFERENCE GUIDE V1.0] 

 

 

Page | 63 

When the Macro is created, notice the TV’s IR commands are running on the handheld 
controller, and the other functions are executed by the processor. 
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Processor Events 

The ProLink processors are capable of executing “Events”.  Events are Macros, residing on the 
processor, which can be initiated by a Power Sense input, processor startup, Driver feedback, or 
a time condition.  Events allow the programmer to “tie” functionality to occurrences within the 
system, such as a door opening, a Driver controlled device powering up or changing inputs, or 
time of day/sunrise/sunset/interval parameters. 

Events are accessed from the Pro Control Devices section of Pro Control Studio by selecting the 
“Edit” button while the processor is highlighted.  Select “Add” to create an Event.  Once the 
Event type is selected, create a Macro to be executed by the Event. 
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Sense Event 

A Sense Event issues a Macro from the processor if a Power Sense input “Goes High” (sees 
voltage) or “Goes Low” (voltage is removed).  

In this example, the processor will issue a command to a Lighting control system based on a 
Sense input, as may occur from a garage door switch or a motion detector. 

 

 

Startup Event 

ProLink processors can issue a Macro when powered on, reset, or a program download is 
performed. Only one Startup Event is allowed, however the Startup Event Macro may contain as 
many steps as is necessary.  For example, the processor may issue a Macro that will re-boot a 
satellite receiver, if power to the system is lost. 

 

 

Periodic Event (ProLink.z only) 

A Periodic Event is a specific Macro that runs on regular time intervals, between 1 second and 
360 minutes. 
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The example Periodic Event triggers a Macro that flashes a controlled lighting load 5 
times if a garage door sensor is open.  It checks the status of the door contact every 15 
minutes. 

 

 

 

Driver Event (ProLink.z only) 

A Driver Event executes a Macro when a Driver reports a specific Variable.  In the example, if the 
A/V receiver is turned on, the TV and Satellite TV tuner turn on, and the A/V receiver and TV 
select the proper input. 
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8. Downloading 

When programming is complete, select the “Download” button from the top toolbar in Pro Control 
Studio. 

 

 
 

Plug the programming cable into both the remote and processor (one at a time), and click the 
“Download” button when the appropriate device is in reference.   
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When downloading to the processor, a “Select a programming method” window will appear.  If 
Ethernet is connected to the processor it will show up in the list by MAC and IP address, and the 
programmer may download to it that way.  If an Ethernet connection is not available, choose the “Use 
USB Connection” button and download via the provided programming cable.  

 

 

 

When downloading, a “Found New Hardware Wizard” window may appear.  Select the toggle for “Yes, 
this time only” and click “Next”.  Accept defaults that the wizard assigns and keep clicking the “Next” 
button.  The necessary drivers are already on the computer and the Wizard will find and apply them. 
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Appendix A:  Installing Pro Control Studio 

Pro Control Studio is available exclusively to registered dealers. The software may be downloaded from 
www.procontrol.com.  To become a registered dealer, please click the “Register” button at the top of 
the screen.  Complete the online form with required information.  

 Once registered, your account will be verified through your distributor and access to the dealer portion 
of the website will be available upon login. A confirmation email will be sent upon approval. 

Locate the “Downloads” tab.  This will contain downloads including Pro Control Studio, firmware 
updates, and drivers. 

Select the Pro Control Studio download link.  This will open a download screen for the .EXE installer. 
Download the setup file to the desired location.  The installation file may be deleted after Pro Control 
Studio is installed. 

Navigate to the file location and open the .EXE and run.  Windows may warn about potential risk in 
installing software or notify that the .EXE is going to make changes to your computer.  Click “Continue” 
or “Yes” to proceed. 

Choose to install Pro Control Studio and USB drivers and click the “Install” button. 

 

 

 

 

http://www.procontrol.com/
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Click “Next” to continue. 

 

 

Please read the End User License Agreement and check the acceptance box.  Select “Next” to continue. 
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Choose a custom destination to install the program, or select “Next” to choose the default location 
(recommended). 

 

Select “Install” to proceed, or “Back” to make changes. 

 

Installation will begin. This process may take several minutes depending upon your system performance. 

 

Select “Finish” to exit the setup. 



V0.3 [PRO CONTROL STUDIO REFERENCE GUIDE V1.0] 

 

 

Page | 72 

 

Pro Control Studio is now installed. 
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Appendix B:  Learning IR Commands 

Learning IR Codes 

On occasion, the programmer may be unable to find the proper code for a unique device or function. 
Pro Control Studio allows learning codes from other IR remote controllers.  

In Pro Control Studio, locate the Controlled Devices area.  From the “Libraries” menu, select “IR Library 
Manager.” 

The IR Library Manager is a software program that is used to create or modify IR Command Libraries. 

An “IR Command Library” is a collection of IR codes grouped into units called “Remotes.”   IR Command 
Libraries store IR codes from remote controls that can be placed in Macros. 
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Step 1: Create Library 

To create a new library, select File>New.  Name the library as desired. 

Codes may not be learned into the Master IR Library, as it is updated frequently and may cause the loss 
of learned codes. 

 

 

 

Step 2: Add the remote to be learned 

Select Remote>New.  Enter information for Manufacturer, Type of Device, and Model Number. 
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The device will be added to the newly-created IR Library. 

 

 

 

Step 3: Edit Functions 

Functions are the IR commands to be learned from the “donor” remote controller.  Functions may be 
added manually or by using the New Function Wizard. 

New Function Wizard: 

From the Edit tab, select the “New Function Wizard” button. 
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If the Wizard recognizes the device type entered in the previous step, a window will appear showing the 
commonly used functions for the device type.  Select the desired functions from the scrolling list.  The 
chosen functions will be added to the Function column of the IR Library Manager. 

 

 

 

 

To manually add functions, type the desired function name under “Add Functions”, or select a function 
from the pull-down list. 

 

 

 

The manually added function(s) will appear in the Function column in alphabetical order.  Functions may 
be deleted, using the “Delete Function” button. 
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Step 4: Capture IR Codes 

Connect the Pro Control remote into the computer via the programming cable (provided).  Select the 
Capture tab from the bottom of the IR Library Manager.  

 

 

 

Align the Remote 

Press the “Align” button in the IR Library Manager.  Place the Pro Control remote in close proximity to 
the “donor” remote controller (+/- 1 foot).  Press and HOLD any button on the “donor” remote 
controller while aiming at the top (screen end) of the Pro Control remote. 

As the Pro Control remote receives an IR signal, the carrier frequency will be displayed on the Pro 
Control remote’s screen.  If no frequency information is displayed, reposition the remotes and see the 
Troubleshooting section for more assistance. 
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Learn IR Commands 

Without moving the remotes, select the “Learn” button in the IR Library Manager.  The Pro Control 
remote will now enter Capture Mode. 

 

 

 

The IR Library Manager will automatically highlight the first function in the current library without an 
associated IR code.   If you want to learn a different function, select it from the function list. 

Press and HOLD the requested function (e.g. "Play”) until the Infrared Library Manager learns the code 
and moves on to the next code.  When a command is learned, a red dot will appear next to the Function 
name. The carrier frequency and repeats will have data. 
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The IR Library Manager will automatically highlight the next listed function.  Continue to learn all 
functions listed in the manner prescribed above. 

When finished, navigate to File>Save.  The default location is recommended. 

 

Viewing IR Codes 

Waveform 

The Waveform tab allows the programmer to see a “picture” of the currently selected IR code. 

 

 

Yellow Waveform:  This portion of the code is sent once. 

Green Waveform:  This portion of the code is repeated. 

Red Waveform:  This represents a portion of the IR code that is very long and condensed for display. 

 

Hex 

The Hex View tab allows you to import, export, and edit codes in the fully learned Hex format (those 
that start with 0000.) All other codes must be converted to this format first. 
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To use Hex View 

1. Select a function in the function list. If there is already an Infrared code associated with that function, 
it will be converted to Hex format and displayed in the "HEX Data" field.  If you select a function that 
does not have an Infrared code, the "HEX Data" box will be empty. 

2. Type in the Hex data for the code, or copy it from an external program (such as a web browser), and 
then right-click in the "HEX Data" box and choose "Paste" from the menu. 

3. Select Apply to update the Infrared code in the library 

If you are converting a large number of codes, you can use the "Auto-Paste" feature to save time. 

 

To use the Auto-Paste function 

1. Click on the Edit tab and add the names of functions you have hex codes for. 

2. Select the Hex View tab and check the "Auto-Paste" box. 

3. Switch over to the application containing the hex data for the currently selected code.  In that 
application, select and copy the hex data to the clipboard. 

4. The IR Library Manager will automatically see the data being copied and paste it to the currently 
selected function. It will then automatically move to the next function, ready to copy the next function's 
data. 

5. Repeat step 3 until all of the codes have been added. 

Note: Not all codes in the library can be represented in Hex format. If you try to view a code that cannot 
be represented in Hex, you will see "<<this code is not represented in HEX format>>" in the Hex Data 
field. 
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Using Learned Codes 

Under Controlled Devices, select Add> Infrared Device.  Choose “User IR Codes” and select the 
appropriate IR Library.  Locate and select the learned IR device. 
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IR Learning Troubleshooting 

 

1. Make sure you hold down the button on the donor remote until the code capture 
process is complete as indicated on the computer screen. 

2.  Always place the Pro Control remote and the donor remote control on a flat surface.  
You may find it necessary to elevate the donor or the capture unit with a book or similar 
object to align them horizontally. 

3.  Once you have learned and tested a code from a remote, try not to move it until you 
have learned all the codes.  If you do accidentally move either remote, you should re-
align them. 

4.  It is VERY IMPORTANT to make sure the donor remote is using fresh batteries.  The Pro 
Control remote needs a strong IR signal to properly learn a code.  If the frequency read-
out in the ALIGN mode is 0.0 kHz, then the code is a pulsed type.   In this case, you 
should transmit the commands to the capture unit from as far away as you can without 
getting an error message. 

5.  If you always get an error message or trouble aligning when trying to learn a code, you 
should try moving the donor remote up and down or back and forth trying various 
angles and distances from the Pro Control remote.  If this does not help, try tapping the 
buttons on the donor instead of holding them down. 

6. Go into the Repeat column of the function and adjust the number of repeats.  Some 
equipment may only work with 0 repeats while others may require as many as 4-5 and 
in extreme cases 7-8 or more.  The number of repeats may also be adjusted in the 
button macro properties in Pro Control Studio as well as the Infrared Library Manager. 
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Appendix C:  Adding Custom Color Graphics 

 
In addition to the supplied templates of graphics that are included with Pro Control Studio, custom 
graphics may be added. 

 Compatible graphic formats include: .BMP, .GIF, .PNG, .JPEG, .TIFF, and .ICO. 

 .PNG is the preferred format, since it allows layers and transparency.  

 

Common graphic sizes (in pixels): 

26 x 26   Small Icons 
 36 x 36   Medium Icons 
 60 x 60   Large Icons 
 69 x 46   TV/Satellite Channel Icons 
 240 x 320  Background Images 

 

Creating Graphics Library 

Navigate to the default directory for Pro Control Studio:  C:\Program Files(x86)\Pro Control\Templates 

Create a new folder, name as desired. 
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Place custom graphics in this new folder 

The added graphics will appear as a new graphics library in the Bitmap Library Browser, identified by 
the name of the folder you have created.   

 

 

 

The added graphics library will appear each time you open Pro Control Studio.   

Note:   If the new library does not appear, restart Pro Control Studio. 

 

Graphic Designations 

Pro Control Studio can identify a desired use for specific graphics, such as for a background or button, by 
the addition of a specific ending to a file name. 

 

Background, Centered:  ̂ #BGCENTER 

Background, Tiled:  ^#BGTILE 

Button, Normal state:  ^#UP 

Button, Active state:  ^#DOWN 
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Appendix D:  Troubleshooting 

 

General Troubleshooting 

 

My remote will not turn on 

When a handheld controller is powered on, a startup screen will be displayed (a few flashes of the 
screen which is normal).  The Pro24.z requires a longer startup time than the Pro24.r, due to its larger 
memory.  Handheld controllers will come preloaded with a demonstration program.  The processors will 
have no file pre-loaded. 

1. Verify the power switch is ON. 

2. Verify the battery is correctly positioned.   The printing on the battery should be visible, and an 
arrow pointing UP on the upper-right corner of the battery. 

3. Contact Pro Control Technical Support:   

support@procontrol.com 

  (952)224-5024 

  Technical support hours, excluding holidays:  8:00am to 5:00pm Monday – Friday CST 

 

My remote will not charge the battery  

Pro Control recommends a 5-6 hour charge before continuous use.  In order to charge a remote, the 
power switch must be in the ON position (see page 7).   

A flashing red battery indicator at the bottom of the remote indicates the battery is still charging. 

 A solid red battery indicator indicates the battery is fully charged. 

Charging the Pro24.r requires the use of a micro USB wall pack (provided).  It may be charged 
with the supplied power adapter, or will charge while connected to a computer USB to micro 
USB cable (provided).   

mailto:support@procontrol.com
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Charging the Pro24.z requires the use of a micro USB wall pack (provided).  The cable may 
connect directly to the controller, or may be connected to the provided charging dock. The 
controller may be charged with the supplied power adapter, or will charge while connected to a 
computer USB to micro USB cable (provided).   

1. Verify the power switch is ON. 

2. Verify the battery is correctly positioned.   The printing on the battery should be visible, and an 
arrow pointing UP on the upper-right corner of the battery. 

3. Try a different charger, battery, and/or micro USB cable. 

4. Contact Pro Control Technical Support:   

support@procontrol.com 

  (952)224-5024 

  Technical support hours, excluding holidays:  8:00am to 5:00pm Monday – Friday CST 

 

 

My processor is not working 

Verify that the processor is plugged in, using the correct power supply provided with the device.  

Confirm that the AC outlet is functioning properly. 

Confirm the power supply is using the correct adaptor for the country of use. 

Verify that the Pro Control Studio system file has been loaded into the processor. 
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IR Command Troubleshooting 
Check the IR Code’s Waveform  

Sometimes the waveform of the IR code can give some clues why they are not working.   

Typically, codes with many red dashes or extremely long waveforms are signs the code is not good.  This 
is simply a rule of thumb, however.  Since most manufacturers use different IR code formats, it can be 
difficult to determine much by simply looking at a single waveform.  It is usually more helpful if you have 
another code set for a similar device from the same manufacturer, or other codes within the same code 
set that are working to compare against. 

Frequency 

The carrier frequency used by a manufacturer is usually consistent between similar models.   In most 
cases, minor differences in frequency (1 KHz or less) will not make a difference.  However, while testing 
it may be helpful to try adjusting the carrier frequency in small increments. 

Repeats 

Enter in this box the number of times that the repeating part of the IR code is sent by the remote. By 
default an IR code programmed on a button will have 1 or more repeats. This is an insurance measure 
and most devices being controlled will interpret this as a single button press. However, some devices 
need a code to be repeated a certain number of times to work properly, and some may not work 
properly if the code is repeated at all. Change this setting only if you are having trouble with a code. If 
the codes are double hitting or are intermittent, this setting may help in that case also. 

Sustain 

Check this box to control whether or not the IR code should repeat if the button is held down.  Most 
infrared codes will transmit continuously as long as the button is held down, but some infrared receivers 
may not work properly if the command is repeated at all.  If the Sustain button is not checked, the code 
will be transmitted only the Minimum Repeat number of time, regardless of how long the button is held 
down. 

Adjust the IR Output Gain 

If using a processor, use a screwdriver to adjust the output gain.  You may need to adjust the gain higher 
if multiple IR emitters are plugged in. 

Try Different IR Codes 

Try some different codes from the Pro Control IR command library from similar models by the same 
manufacturer.  If the IR library does not list your specific model of a device, in many cases 
manufacturers will use the same IR code sets for many models. 

Check the Positioning of any attached IR Emitters 
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